Getting Started with EMS Desktop Client

- Getting Started with EMS Desktop Client
  - What is the EMS Desktop Client?
    - Reservations and Bookings
    - What is an Everyday User Reservation?
  - Starting EMS
    - Managing Database Connections
  - The EMS Window
    - Toolbar Buttons
    - Toolbar Cheatsheet
    - What is a Wizard?
    - What You Should Know About EMS Browser Windows
  - User Settings
  - Using the Dashboard
    - Working With the Dashboard
    - Managing Requests for Managed Space
    - Guest Requests Tab
    - Notifications Tab
    - Reminders Tab
    - Everyday User Reservations Tab
    - Wait List Tab
    - Reconfirm Dates Tab
    - Building Hours Exceptions Tab
    - Analytics Tab
    - At A Glance Tab
Getting Started with EMS Desktop Client

This page was not added to the PDF due to the following tag(s): article:topic-guide
What is the EMS Desktop Client?

**EMS Desktop Client is the “core” administration system for all EMS Everyday User applications**

This desktop application is used by expert users to automate workflows and communications for maximum scheduling efficiency. This tool enables Everyday users to request space and services, see available space, check their calendar, check into meetings, change event details, end and cancel events, resolve booking conflicts, delegate space management to other users, send invitations, invoices, and notifications, approve requests, track resource usage, and track space utilization.

**Concept:** Configuration elements (click to expand) in EMS Desktop Client control what users can see and do in EMS Everyday User Applications.

*Expert users* include conference center managers, event coordinators, registrars, facility and real estate managers, and service providers. They can use this tool to set up and control the booking process and booking templates, define space (buildings, rooms, floors, areas, and regions), define services, manage security and user permissions, grant access, initiate notifications and reports, and integrate with other applications, servers, databases, and systems. *Everyday users*, such as an employee who needs to book a conference room or a consultant who needs to book a hoteling space for the day, can use it to make reservations and book meetings.

Who Uses EMS?

There are two different user types for EMS software:
1. **Administrators**: These users create and maintain the EMS application within your organization, and manage or approve usage of space. This user type may also include Service Providers (Catering, Audio Visual, IT Support Staff), Security, and Receptionist Staff. These users will primarily use the EMS Desktop Client.

2. **Everyday Users**: This is the majority of the users in the organization. Everyday users are typically requesting rooms and services. These users do not use the EMS Desktop Client. They generally use web-based EMS applications such as EMS Web App and EMS Mobile App.
Reservations and Bookings

The two essential EMS components for meeting and event scheduling are reservations and bookings. To use the EMS Web Client efficiently and effectively, you must understand the structure of a reservation in EMS, the concept of an event timeline for a reservation booking, and how to make a reservation. This section covers the following topics:

- Reservation Structure
- Event Timeline
- Making a Reservation Using the Reservation Wizard
- Viewing and Editing Reservations in the Reservation Book

Reservation Structure

An event in EMS Desktop Client is comprised of the following:

1. A Reservation
2. One or more Bookings
3. Booking details

These three components exist in a hierarchy—a reservation contains one or more bookings and each booking can have one or more details associated with it.

Reservations

A reservation is the who and the what of an event. For example, Group X (the who) can reserve some space for an Event Y (the what). A booking is the where and the when of an event. For example, Group X can schedule the conference room (the where) for a staff meeting on the second Monday in January (the when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules the conference room (the where) for a staff meeting on the second Monday of each month for a calendar year (the when), then Group X now has a single reservation with twelve bookings in EMS.

Booking Details

A booking can have one or more booking details associated with it. Booking details are the resources or services that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for Group X’s staff meeting, the resources could include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and so on).
Event Timeline

The following time designators are used for an event in EMS Desktop Client:

- **Event Time**: The time period during which the event actually takes place.
- **Setup/Teardown Hours**: The hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up after the event.
- **Reserved Time**: The total time for which the space (the where) is reserved. This time is the event time plus the setup/teardown time.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Start Time</td>
<td>8:00 a.m.</td>
</tr>
<tr>
<td>Setup Hours</td>
<td>1 hour</td>
</tr>
<tr>
<td>Event Start Time</td>
<td>9:00 a.m.</td>
</tr>
<tr>
<td>Event End Time</td>
<td>4:00 p.m.</td>
</tr>
<tr>
<td>Teardown Hours</td>
<td>1.5 hours</td>
</tr>
<tr>
<td>Reserved End Time</td>
<td>5:30 p.m.</td>
</tr>
<tr>
<td>Reserved Time</td>
<td>9.5 hours</td>
</tr>
</tbody>
</table>

Making a Reservation Using the Reservation Wizard

The Reservation Wizard allows you to check for available space and make a reservation for an event. You can search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms. To make a reservation using the wizard, you must:

- Specify the event date and time information.
- Specify the event time and status.
- Select the event location.
- Specify the event information.

**Note:** The following procedure describes how to make a reservation by selecting values for the required and optional fields.

- If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard Template dropdown list is displayed at the top of the Reservation Wizard. You can facilitate the making of a reservation in the Reservation Wizard by selecting the appropriate template from the list, which automatically sets the default values for many of the fields in the Reservation Wizard.
• If your job entails making multiple reservations that require the same information, and you are not using reservation wizard templates, then you can set your own default values for many of the fields in the Reservation Wizard.

To specify the event date and time information:

1. On the EMS Desktop Client toolbar, click the Wizard icon. The Reservation Wizard page opens.
2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different month (< or >), or click a month at the top of the calendar to open a dropdown list from which you can select a different month. You can also click a year at the top of the calendar to open a dropdown list from which you can select a different year.
3. If the event dates do not follow a pattern, use one or more of the following options for entering a date:
   ◦ Click on the dates on the calendar that the event is to take place.
   ◦ To select all five weekdays in a week, click in the blank space that is to the left of the week.
   ◦ To select all seven days in a week, double-click in the blank space that is to the left of the week.
   ◦ To select every occurrence of a specific day of the week for the displayed month (for example, all Sundays in June, 2017), click the heading (S, M, T, and so on) for the day.
   ◦ To select every occurrence of a specific day of the week that is currently displayed onscreen (regardless if the day falls within the same month), double-click the heading (S, M, T, and so on) for the day.
4. If the event dates do follow a pattern, (for example, the third Friday of every month), click Date Pattern at the bottom of the Calendar to open the Date Pattern dialog box and enter your event date information. As you specify the event dates, the following occurs:
   ◦ The Selected Dates tab at the top of the Calendar is automatically updated with the selected dates.
   ◦ If your EMS administrator has configured any of the dates as a holiday or closed, then holiday dates are displayed in green on the Calendar tab and closed dates are displayed in red. For any date, after you select the date on the Calendar tab, you can:
     • Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates tab, select the date, and then click Go To Date.
     • You can remove a date from the list of selected dates by opening the Selected Dates tab, selecting the date (or CTRL-click to select multiple dates), and clicking Remove.
   ◦ For dates that are configured as a holiday or as closed, you can:
     • Place your cursor on a holiday date to open a tooltip that shows the name of the holiday.
     • View information about the date from the Selected Dates tab. Open the Selected Dates tab, scroll to the date, and then click Holidays to open a Holidays dialog box that displays information about the holiday.
     • Place your cursor on a closed date to open a message that states that you cannot select the date because the date is closed.
5. Continue to specify the event time and status.

To specify the event time and status:

1. Specify the start time and end time for the event in one of two ways:
   • Click the Time Picker icon to open a dropdown list from which you can select a time for each field
• Under the **Time** section, manually enter the start and end times from the dropdowns. If applicable, select the appropriate Time Zone for the event.

2. Specify the Setup and Teardown times in one of two ways:
   - To use the default setup and teardown times that your EMS administrator has assigned to the rooms in your system, leave the **Use Default** checkbox selected.
   - Override the default setup/teardown times by clearing the **Use Default** checkbox, and selecting **Minutes or Hours**, and entering your own setup and teardown times.

3. Indicate the status for the event.

4. Continue to select the event location.

---

**To select the event location:**

You have three options for selecting the event location, which are indicated on the first page of the Reservation Wizard:

I. **Standard**: Use this option to display a list of all the available rooms that meet all the requested dates.

II. **Best Fit**: Use this option if no one room can meet all the requested dates. The system lists rooms along with the number of bookings for which you can reserve the room. You can piece together the entire reservation using Best Fit, or just part of it.

III. **Specific Room**: Use this option to confirm the availability and reserve of one specific room for the scheduled event.

I. To search for a standard room:

1. Select **Standard**.

2. Choose one of the following for room specifications:
   - **Type** is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.
   - **Floor** is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.
   - **Setup Type** is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.
   - **Setup Count** is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

5. To select a Feature, open the **Features** tab, select the Feature, or CTRL-click to select the multiple features that the room must have.

6. Click **Next**. Up to two tabs are displayed:
   - The **Available tab**, which is the active tab and is always displayed, lists all the rooms that meet all your event criteria.
     - If you have elected to show the Available All Day Indicator, the rooms that are available all day are marked with an asterisk (*).
     - By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)
• The **Conflicts tab** is displayed only if there are rooms that are not available for the requested dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling as well as list of the events that are scheduled for each room.

7. Select the room, or CTRL-click to select the multiple rooms that you are scheduling for the event.

8. Click **Room Info** to open the Room Info dialog box and view information about the room properties, notes, Room URL, Building URL, setup type and capacity, and features. Click **Close**.

9. Click **Building Hours** to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date. Click **Close**.

10. Click the Move button (> ) to move the rooms to the Selected list.

11. Click **Next** to **specify the event information**.

**II. To search for a best fit room:**

1. Select **Best Fit**.

2. Leave **Building** set to the default value of (all), or select a specific Building, Area, or View in which to search for a best fit room.

3. Choose one of the following for room specifications:

   • **Type** is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.

   • **Floor** is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.

   • **Setup Type** is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.

   • **Setup Count** is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

5. Open the **Features tab**, and then select the feature, or CTRL-click to select the multiple features that the room must have.

6. Click **Next**. Up to two tabs are displayed:

   • The **Available tab**, which is the active tab and is always displayed, has two lists. The list in the left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right pane is a list of all the event dates that must be fulfilled.

   • The **Conflicts tab** is displayed only if there are rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.

7. Choose one or both of the following:

   • Click **Room Info** to open the Room Info dialog box and view information about the room properties, notes, Room URL, Building URL, setup type and capacity, and features. Click **Close**.

   • Click **Building Hours** to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date. Click **Close**.

8. Choose one of the following:

   • If one is available, select the single room that is available for all the requested dates, and then click the Move button (> ) to move the room to the Event Dates list.
• If a single room is not available, select a room that is available for some of your requested dates, and then click the Move button (>) to move the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to specify the event information.

III. To search for a specific room:

You can use the Specific Room search to book a standard EMS room or a room or area that is not managed in EMS. An override room, or "override description," is used to book an event in a space that has not been configured in your EMS system. For example, your EMS administrator might have configured an override room named “Other Area” in the Engineering building. To book an event in Dr. Wilson's office, which is a room that is not defined in EMS, in the Engineering building, you can select the “Other Area” room and specify “Dr. Wilson's Office” for the location. EMS does not track availability for events booked in override rooms; however, EMS reports on events that are scheduled in an override room just like any other event scheduled for any other room.

1. Select Specific Room. The Room Selector dialog box opens. By default, (all) buildings is selected.

2. Do one of the following:
   • To select a room from a list of all rooms in all available buildings:
     ◦ Leave (all) selected on the Buildings dropdown list.
     ◦ Click the Add icon next to a room to select it.
     ◦ If the room is configured as an override room, continue to the next step.
   • To select a room from a list of rooms in a specific building, area, or view:
     ◦ Select a specific building, area, or view.
     ◦ Click the Add icon next to a room to select it.
     ◦ If the room is configured as an override room, continue to the next step:
       ◦ In the Location field, enter the location of the override room, and then click Next.
       Two results are possible:
       ◦ If the event is scheduled for a single date and the room is available, then continue to the next step.
       ◦ In all other cases, (for example, the event is scheduled for a single date but the room is not available or it is a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific room is available.

5. Optionally, before you move a date to the Selected list, click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the selected date.

6. Optionally, before you move a date to the Selected list, do one or both of the following:
   • Click Room Info to open the Room Info dialog box and view information about the room properties, setup type, features, and pricing.
   • Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

7. Do one of the following:
   • If the specific room is available for all the event dates, then click the Move All button (>>) to schedule the room for all the event dates.
   • If the specific room is not available, try another approach such as reserving a different specific room, or using the Standard or Best Fit search method.
8. Click **Next**.

**To specify the event information:**

After you select an event location(s), you must specify other information for the event.

1. Enter the event information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event</strong></td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td>A name or description for the event.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The classification for the event.</td>
</tr>
<tr>
<td>VIP Event</td>
<td>Select this option to mark the event as a Very Important event.</td>
</tr>
<tr>
<td>Source</td>
<td>The reservation source.</td>
</tr>
<tr>
<td>Video Conference</td>
<td>Select this option for a video conference event.</td>
</tr>
</tbody>
</table>

**Employee/Contact**

Click the Search icon to open an **Employees** dialog box in which you search for and select a specific employee from a list all employees that are available in your system for hosting/sponsoring an event.

- To search a list of all employees, leave the Find field in the Lookup dialog box blank, and then click the Search icon.
- To search for a specific employee, enter a search string in the Find field, and then click Search icon. Your search is limited to the exact order of the characters in the string, but the string can appear anywhere in the search results and it is not case-sensitive. For example, the search string *sim* returns Paske, Simon and Simington, Chance.
- To select an employee, click the Add icon next to the employee.
- If the employee that you want to select for the reservation is not available on the pre-configured list, then you can click the Employee icon to open the Employee dialog box and add the employee.

**Note:** After you select an employee, you can click Employee Info at the bottom of the Reservation Wizard page to open a dialog box that displays the properties for the employee, any user-defined fields for the employee, and any comments that are associated with the employee.

**1st Contact**

When you select a group, if a **default** contact has been defined for the group, then this field is automatically populated with the name of the contact; otherwise, the field is blank. You have several options for defining the 1st Contact for a reservation:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2nd Contact</strong></td>
<td>Define if necessary for the event.</td>
</tr>
<tr>
<td><strong>Temp Contact</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Phone</strong></td>
<td>One more of these fields might be automatically populated depending on how a selected contact has been configured. You can manually edit these values if needed.</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Room Setup tab</strong></td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can select a setup type for this field, or if the field is already populated, you can select a different setup type.</td>
</tr>
<tr>
<td><strong>Setup Type</strong></td>
<td>If you entered a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can enter a value in this field, or if the field is populated, modify the value.</td>
</tr>
<tr>
<td><strong>Setup Count</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Billing tab**

**Note**: Depending on the group that you select, one or more of these fields might be automatically populated with default values. You can edit these default values but any modifications that you make
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pricing Plan</td>
<td>Indicates what type of pricing is to be used for the event.</td>
</tr>
<tr>
<td>Cost Center Number</td>
<td>The internal alphanumeric billing code that is associated with the group. You can manually enter a value in this field, or if a master list of billing reference numbers has been configured for the group, you can click the Search icon to open a <strong>Cost Center Numbers</strong> dialog box, and select the appropriate value from this list.</td>
</tr>
<tr>
<td>Sales Category</td>
<td>How the group is sorted for purposes of tracking sales figures (e.g., local, regional, national, etc.).</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Indicates how the group paid for the event (cash, check, charged, and so on).</td>
</tr>
<tr>
<td>Dept. Code/PO Number</td>
<td>The internal alphanumeric purchase order number that is associated with the group. You can manually enter a value in this field, or if a master list of purchase order numbers has been configured for the group, you can click the Search icon to open a Purchase Order Numbers dialog box, and select the appropriate value from this list.</td>
</tr>
<tr>
<td>Salesperson</td>
<td>The user who “sold” the event.</td>
</tr>
</tbody>
</table>

**Note:** To search for a specific cost center number, enter a search string in the Find field, and then click the Search icon. The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a string of co returns CO-123, but not 123-CO.

**Note:** To search for a specific purchase number, enter a search string in the Find field, and then click the Search icon. The string is not case sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a string of co returns CO-123, but not 123-CO.

**Other tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Coordinator</td>
<td>The Event Coordinator assigned to the event.</td>
</tr>
<tr>
<td>Estimated Event Attendance</td>
<td>The estimated number of people who are expected to attend the event.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
Calendar Style | Dropdown list of all the available formats for printing this event on the Event Calendar and Event Schedule reports.
URL | The event URL.

### Virtual tab

- To specify the everyday users who can view/manage this reservation in VEMS, click the Search icon to open the Everyday Users search dialog box and search from a list of registered everyday users.
- You can search by **User Name** or **Email Address**
- To search a list of all available everyday users, leave the Find field in the Lookup dialog box blank, and then click the Search icon
- To search for a specific everyday user, enter a search string in the Find field, and then click Search icon

**Note:** The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of **bb** returns **bbosworth@dea.com** but not **dbobbett@dea.com**.
- To select an everyday user, click the **Add** icon next to the user.

**Note:** To return this field to the (no change) value at any time, click **Reset**.

### Everyday User

The process template that defines the functions that are available for the selected everyday user.

**Note:** An everyday user might be assigned to more than one process template, so make sure to select the template that is applicable for this reservation.

### User Defined Fields tab

User-defined fields are additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields.

- To enter or modify a value for a field, select the field, and then click **Set Value**.
- To clear a value for a field, select the field, and then click **Clear Value**.

**Note:** If a user-defined field is not required here, you can always supply a value for it at a later date in the Navigator.

2. Click **Finish**. Two results are possible:
a. If you did not enter information into required fields, then these fields are outlined in red. You must enter values into these fields and then click Finish again to open the Navigator page.

b. The Navigator opens. The reservation information is displayed in the Navigator. You use the Navigator to add booking details and to make any needed modifications to the reservation and its bookings.

**Warning:** A reservation is not complete and rooms are not removed from the Available list until you click **Finish**. Although unlikely, it is possible for another user to select and reserve a room during the time period after you have selected the room but before you have finalized the reservation. If this occurs, after you click Finish, a message opens stating that your reservation conflicts with an existing reservation.

---

**Viewing and Editing Reservations in the Reservation Book**

The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not shown.) You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to make a new reservation. In addition, when the Reservation Book first opens, before you edit or make a reservation, you can change the Reservation Book view so that it better suits your working needs.

This section will provide information on the following topics:

- Opening the Reservation Book
- Changing the Reservation Book display
- Viewing Reservation Information
- Making a New Reservation
- Editing an Existing Reservation

**To open the Reservation Book**

1. From the toolbar, click the Book icon. The first time that you open the Reservation Book for your EMS implementation, by default, the Filter dialog box opens on top of a blank Reservation Book. You can leave the room filtering criteria set to their default values, or you can select different values as needed, and then click OK. All reservations that meet the filtering criteria and that are scheduled for the current day’s date are displayed in the book in the Daily view.

**Tip:** You might need to use the book’s scroll features to scroll through all the reservations that are scheduled for the current day’s date.

- If an event is scheduled for a room that is a component of a combination room, then the reservation text is displayed in black. A duplicate reservation is also shown for the combination room; however, the reservation text is displayed in gray to indicate that a component of the combination room is currently booked for the indicated time and therefore, the combination room is not available
- Conversely, if an event is scheduled for a combination room, then the reservation text for the combination room is displayed in black and the reservation text for each component is displayed in gray. This reversed color
coding indicates that the component room is currently booked for the selected time and that none of the components is available.

Tip: The Reservation Book has the following appearance:

- Minimum and maximum capacities are displayed next to room descriptions
- The current time is shown by a vertical line in the grid, called the Current Time Indicator
- If building hours have been configured for a building, then this information is displayed for the building

The reservations are displayed with three components:

- A left bar that indicates the setup time
- A middle bar that indicates, by default, the event name
- A right bar that indicates the teardown time

To change the Reservation Book display:

2. You can change the Reservation Book display in the following ways:
   - Change the list of rooms that are displayed in the Reservation Book based on room properties.
   - Change the list of rooms that are displayed in the Reservation Book based on a specific room(s).
   - Change the Reservation Book view.
   - Change multiple display options for a reservation.
   - Select which items to include in the tooltip that opens when you place the cursor over an event in the Reservation Book.
   - Change the display date using the calendar.
   - Change the display date using the Reservation Book scroll features.
3. To change the list of rooms based on room properties:
   a. Click Filter if the Filter dialog box is not already open.
   b. Select Room Properties and customize one or more of the following:
      - Leave the Building dropdown list set to the default value of (all) buildings, or select a specific building, area, or view.
      - Select a specific floor.
      - Select a specific room type.
      - Select Capacity and then enter a capacity.
      - Select Academic to limit the search to academic rooms.
      - Select a Room Availability option.
   c. Click OK. The Filter Rooms dialog box closes. The room display in the Reservation Book is changed accordingly.
4. To change the list of rooms that are displayed in the Reservation Book based on a specific room or rooms:
a. If the Filter Rooms dialog box is not already open, then above the Rooms list, click **Filter** to open the dialog box and select Specific Room.

b. Select the room, or CTRL-click to select multiple rooms on the Available list.

c. Click the **Move** (>) button to move the selected rooms to the Selected list. The Reservation Book is updated to show bookings only for the selected rooms.

5. To change the Reservation Book view:

   a. From the View dropdown list, select Daily, Weekly, or Monthly.

6. To change multiple **display options** for a reservation:

   a. Click **Options** (upper right hand corner of Reservation Book) to open the Book Options dialog box (the General tab is the active tab).

   b. Change multiple display options not only for the Reservation Book, but also a reservation in the book.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Hour</td>
<td>The daily start time for the Reservation Book display.</td>
</tr>
<tr>
<td>Display</td>
<td>The information that is displayed in the middle bar for a reservation.</td>
</tr>
<tr>
<td>Time Display Interval</td>
<td>Changes the granularity of the time display interval.</td>
</tr>
<tr>
<td>Maximum Number of Rooms</td>
<td>The maximum number of rooms to display in the Reservation Book.</td>
</tr>
<tr>
<td>Booking Colors Based On</td>
<td>The color of the bookings in the reservation. Select one: Status, Event Type, or Check-in Status (for EMS Workplace only.)</td>
</tr>
<tr>
<td>Rooms Without Bookings</td>
<td>Whether to highlight rooms without bookings and if so, the highlight color. If both Highlight Rooms and Booked Space Status Only are selected, then only those rooms that do not have a Booked Space status are highlighted.</td>
</tr>
<tr>
<td>Room Display</td>
<td>Display the room code or the room name for a reservation.</td>
</tr>
<tr>
<td>Building Display</td>
<td>Display the building code or the building name for a reservation.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Go To Today on Startup</td>
<td>If selected, the Reservation Book opens to the current day’s date; otherwise, it opens to the last date viewed.</td>
</tr>
<tr>
<td>Always Prompt for Room Filter on Startup</td>
<td>If Show ‘(all)’ in Building List is also selected, then when you open the Reservation Book, the Filter dialog box opens on top of the Reservation Book. You can select different options on this dialog box to display only specific reservations in the book, for example, bookings only for selected rooms. If you do not select any options on this dialog box, but instead simply close it, then all reservations for all rooms in all buildings are displayed in the book.</td>
</tr>
<tr>
<td>Hide Current Time Indicator</td>
<td>Show or hide the vertical bar that indicates the current time for current day.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Current Time indicator is displayed only if the view is the Daily or Weekly view and the view includes the current day’s date.</td>
</tr>
<tr>
<td>Show ‘(all)’ in Building List</td>
<td>Show the “all” option on the Building dropdown list; otherwise, a user must select a specific building. If this option is selected in conjunction with Always Prompt for Room Filter on Startup, then when you open the Reservation Book, then the Filter dialog box always opens on top of the Reservation Book. If you are setting your Reservation Book options, and you do not want to the Filter dialog box to open on top of the Reservation Book when you open the book, then do the following:</td>
</tr>
<tr>
<td></td>
<td>• Clear Always Prompt for Room Filter on Startup.</td>
</tr>
<tr>
<td></td>
<td>• Clear Show (‘all’) in Building List.</td>
</tr>
<tr>
<td></td>
<td>• On the Building dropdown list in the Reservation Book, select any building, area, or view.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The building, area, or view that you select is not important. This last step just clears the “all” building option from the Reservation Book cache and ensures that the Filter dialog box does not open on top of the Reservation Book. Going forward, you can always select all buildings, or any specific building, area, or view as needed when you are working in the Reservation Book.</td>
</tr>
<tr>
<td>Show Capacity</td>
<td>Show the minimum and maximum capacities next to the room description.</td>
</tr>
<tr>
<td>Hide Booking Shadow</td>
<td>Hide the vertical shadow bar that highlights the reserved and/or event start times and end times when a user moves a booking in the Reservation Book.</td>
</tr>
</tbody>
</table>

7. To select which items to include in the **tooltip** that opens when you place the cursor over an event in the Reservation Book:

   a. Click **Options** (upper right hand corner of Reservation Book) to open the Book Options dialog box.

   b. Open the **Tooltip Display** tab and select which items to include in the tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.
8. To change the display date using the calendar:
   a. From the Date field, click the dropdown arrow to open the Calendar.
   b. Use the (< and >) scroll features at the top of the calendar to change the month or use the (>) scroll features at the top of the calendar to change the year.
   c. To select a different date for a month, click the date.

9. To change the display date using the Reservation Book scroll features:
   a. Use the scroll features at the top of the reservation book display to scroll to a different day, week, month, or any different combination of these.
   b. To reset the display immediately to the current day’s date, click Today.

To view reservation information:
1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.
2. To view the reservation in the Navigator, double-click the middle bar for the reservation entry or right-click the reservation entry and on the context menu that opens, click Open.
3. You can view the reservation information in the following ways:
   • View the bookings for a room
   • View the properties for a room
   • View the pricing for a booked room
   • View the setup information, event information, or teardown information for a reservation.

4. To view the bookings for a room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box. The tab on this dialog box lists all the bookings for the selected room based on the current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field.
   b. To view a booking in the Navigator, select the booking, and then click Open.

5. To view room properties:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the Room tab. The tab on this dialog box lists all the properties for the room, such as the room code, the room name, the room classification, etc. It also lists the setup type and capacity for the room, and any notes that have been entered for the room.

6. To view the pricing for a booked room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the Pricing tab. This tab displays any pricing information that was defined for the room.
7. To view the room setup information, event information, or teardown information for a reservation:

   a. Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tooltip showing the respective setup, event, or teardown information opens.

   b. If buildings that are located in multiple time zones are currently displayed, you can specify the time zone in which to view all of your bookings.

To make a new reservation:

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Change the display to show the room for which you are making the reservation.

3. Select the date for which you are making the reservation.

4. In the Time Grid for the room, click and hold the left mouse button, drag the mouse to schedule the room and time, and then release the mouse button to open the Reservation Wizard. See Making a Reservation Using the Reservation Wizard.

To edit an existing reservation:

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Optionally, you can do one or more of the following to edit an existing reservation:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the setup time for a reservation</td>
<td>• Drag the left bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the event time</td>
<td>• Drag the middle bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the teardown time for a reservation</td>
<td>• Drag the right bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Edit the reservation building, room, time,</td>
<td>• Drag and drop the reservation to a new room that is the same building or in a different building, and/or to a new time.</td>
</tr>
<tr>
<td>or both</td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
</tbody>
</table>

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu that opens, select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a reservation in the EMS Navigator.</td>
</tr>
<tr>
<td>Move Forward</td>
<td>Move the reservation date forward by one day or one week.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Move Backward</td>
<td>Move the reservation date backward by one day or one week.</td>
</tr>
<tr>
<td>Move to a Specific Date</td>
<td>Move the reservation to a specific date.</td>
</tr>
<tr>
<td>Change Status</td>
<td>Change the status of the reservation.</td>
</tr>
<tr>
<td>Copy Bookings</td>
<td>N/A</td>
</tr>
<tr>
<td>Note: Although this option is available on the context menu for a reservation, its associated functionality is currently under development.</td>
<td></td>
</tr>
<tr>
<td>Swap Rooms With Another Booking</td>
<td>Swap the room assignments of two events. The swap option is applicable only for two events that have identical meeting patterns.</td>
</tr>
<tr>
<td>Highlight Related Reservations</td>
<td>Highlights the bookings that belong to the same reservation.</td>
</tr>
</tbody>
</table>
What is an Everyday User Reservation?

Concept: An Everyday User Reservation is any reservation that a user has submitted through EMS Web App.

The everyday user reservation searching tool in the EMS Desktop Client is identical to the Browser searching tool with one exception: when the Browser opens for the first time, the Browse for function is set to Reservations whereas the Everyday User Reservation tool is set to Everyday User Reservations. As a result, although this section is written from the perspective of using the Browser, all the information can be applied when using the Everyday User Reservation searching tool.

To open this tool in EMS Desktop Client, click the Everyday User Reservations icon on the EMS toolbar.

![ Everyday User Reservations ](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/001_What_is_the_EMS_Desktop_Client%3F/What_is_an_Everyday_User_Reservation%3F)
Starting EMS

After EMS has been installed on your desktop, a shortcut icon for the application is placed on your desktop. An option for the application is also available from your Start menu. You can double-click the desktop icon to launch the EMS application, or you can select the option from your Start menu.

1. On your desktop, double-click the EMS icon

, or, in the Windows start menu in the Search field, enter EMS and then select the EMS option. The application launches, prompting you to enter your credentials.

2. Enter your User ID and Password.

Tip: If you have an EMS Enterprise license, you can change the server and database you are connecting to by right-clicking on the About EMS Enterprise option.
This launches a pop-up window where you can choose a different server and database.

Provide Server Parameters

Server: [local]
Database: romanpeshkov_E_44_44

4. Click OK. The EMS Desktop Client application opens. The main menu is open in the application.
Managing Database Connections

If EMS Desktop Client has been installed on your desktop using the EMS Desktop Client Web Deployment, you can point to a different database through EMS Desktop Client. Contact your system administrator for guidance in databases to use.

Changing Databases

1. On the EMS Menu select File > Change Database to bring up the Database Connections window.

   ![Database Connections Window](image)

   **Note:** Any database connection listed in blue is a system record inherited from the EMS Desktop Client Web Deployment that can not be deleted.

2. To connect to a database that is not the system database select it from the list of Database Connections then press the 'Connect' button. This will close and reopen the EMS Desktop Client connected to the selected database.

   **Note:** The user will need to log in again after changing databases.
Creating New Database Connections

1. To create a New connection select 'New' in the Database Connections window (shown above) to bring up the Database Connection window.

2. Type in the SQL server and EMS database name then select 'OK' to save the connection. You can delete connections later when you no longer need them.

3. For EMS to save this connection it will first check to see if it is a valid connection. If the connection is invalid, it will not be created you will see this error message:
The EMS Window

The EMS main window is your starting point for the EMS application. The window provides quick access to all the EMS functions (Reservations, Reports, Configuration, and so on) and system tools. The EMS Main window has four major components:

1. **The Title bar.**
2. **The Menu bar.**
3. **The Toolbar.**
4. **Main Menu.**

Title Bar

The name of the software, EMS Software, and the version number of the application appear in the title bar across the top of the main window.

Menu Bar

The menu bar is set up in a standard Windows menu format with menu commands grouped into menus (File, Settings, Reservations, and so on) across the menu bar. Some of these menu commands are also available in the main menu.

Toolbar

The toolbar provides quick access to the most commonly used functions. The toolbar buttons that are always displayed by default are the buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User Reservations, Clients, Email, Dashboard, and Manage Services. Other buttons for other functions are also displayed by default depending on the
version of EMS that you are running, for example, EMS Academic Planning or EMS Workplace. Some of the functions that are available on the toolbar are also available from the main menu. You can customize the appearance of this toolbar to best suit your business needs. See Also: Toolbar Buttons.

Main Menu

The main menu gives you access to the main EMS functions: Reservations, Reports, Billing, Configuration, and System Administration.

The main menu is arranged in a hierarchical folder structure. The top-level folders are the system functions of Reservations, Reports, Billing, Billing, Configuration, and System Administration. The available tasks for each top-level folder are further organized into subfolders. For example, to perform a system administration task, you must first open the top-level System Administration folder, and then open the correct subfolder to view the list of available tasks.
You can always close the main menu by clicking the Close button in the upper right corner. To open the main menu again, on the menu bar, click File > Show Main Menu.
Toolbar Buttons

The toolbar always displays buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User Reservations, Groups, Email, Dashboard, and Manage Services. Other buttons for other functions may also display, depending on the version of EMS that you are running (such as EMS Campus or EMS Workplace) and additional components your organization may have installed, such as EMS Glance or the EMS Polycom Interface. Some of the functions that are available on the toolbar are also available from the main menu. You can customize the appearance of this toolbar to best suit your business needs; keep in mind that your System Administrator may have re-labeled these options with different names than the examples shown in this topic.

Tip: If you are new to EMS Desktop Client, we recommend that you print out this Quickstart Guide.

Book

Often called the "Reservation Book," this window shows all confirmed reservations (time and room) for your organization. Canceled bookings are not shown. You can use the Book to view and edit existing reservation, and to make new reservations. For detailed instructions, See Also: Using the Reservation Book.

Calendar

You use the Calendar to quickly find for reservations, bookings, and service orders using basic or advanced criteria; results are displayed in a calendar view. See Also: Using the Calendar.
Wizard

You use the Reservation Wizard to make reservations using a streamlined booking template. See Also: Using the Reservation Wizard.

Navigator

The Navigator enables you to view and manage all aspects of a reservation including bookings and booking details. This window also presents whenever you open a reservation for editing from other pages in EMS Desktop Client. See Also: The Navigator Overview.

Browser

& Everyday User Reservations

Authorized users can use the Browser or Everyday User Reservations Browser to search at a very detailed level for reservations, web reservations, bookings, service orders, resources, and queries. See Also: Searching with the Browser.

Groups

Your organization may have re-labeled this button, “Customers” or “Employees.” You can use this browser to search for groups or individuals and reservations and bookings made on their behalf. See Also: Groups and Contacts.
Email

If your system is configured to use SMTP email, clicking this button launches a generic email window. For detailed instructions, See Also: Sending Email from EMS.

Dashboard

Authorized users can access this window for centralized information about reservations in a single location. They typically use this feature to plan day-to-day tasks, such as set and check reminders, send or read notifications, approve or check the status of meeting and service order requests, and review the latest changes to events. See Also: Overview of the EMS Dashboard.

Manage Services

You use Manage Services to search for and view the resources with and without service orders for all bookings on a particular day as well as the current state of the resources and their Reviewed status. After viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if necessary. See Also: Managing Services.

Group Reservations

If your organization has licensed EMS Workplace, you may see Group Reservation icon in your toolbar. This feature enables you to manage and make reservations for Groups in a centralized location. See Also: Working With Information For a Group.
Toolbar Cheatsheet

EMS Toolbars

The EMS Toolbar can be customized and re-arranged. Options available in the toolbar are different based on the version of EMS.

Reservation Tools

- Book: Opens the Reservation Book and displays a grid view of spaces and events.
- Calendar: Opens a Calendar view of events and service orders.
- Wizard: Opens the Reservation Wizard. Quick tool to start reservations.
- Navigator: This tool allows you to quickly jump to existing reservations/booking/service orders.
- Groups: This allows you to browse and edit your Groups/Contacts.

Other Options

- Email: Opens an email editor screen that allows you to send an email through EMS (message is not tracked).
- Web Reservations: Opens up a browser that allows you to search for reservations that have been made via Virtual EMS (Self-Service Requests).
- Dashboard: Opens the user Dashboard. Dashboard has the following components: Notifications, Course Updates, Reminders, Web Reservations, Web Requests, At A Glance, Building Hour Exceptions, Wait List, Reconform Dates, Analytics.
- Manage Services: Opens the Manage Services dashboard. Useful for managing service provider's statuses and statuses.
- EMS Glance Settings: Tool opens EMS Glance preferences and settings.

EMS Campus Tools

- Manage Terms: Opens the Manage Terms window. Allows for Sync, Publishing and Un-publishing of course information and editing of term parameters.
- Academic Browser: Browser specific to courses brought in from SIS.
- Academic Book: At a glance view of course information available in two formats: room and instructor.
What is a Wizard?

Concept: Wizards are pop-up windows that enable end-users to make the same changes to more than one record at a time. These powerful tools are available in several areas of EMS software applications, including EMS Desktop Client and EMS for Outlook. Additional wizards are provided for System Administrators to help them quickly configure elements on the back-end, such as currencies, rooms, resources, and building hours.

Reservation Wizards in EMS Desktop Client

Authorized users have access to the following wizards in the Navigator for making batch-changes to multiple reservations and their child bookings at once:

Booking Wizards in EMS Desktop Client

Four Wizards are available from Navigator in EMS Desktop Client for changing the when and where information for multiple bookings in a reservation.

See Also:
• Change Booking Date/Time Wizard

• Change Booking Status Wizard (which includes canceling multiple bookings in a single step)

• Change Rooms Wizard

• Change Miscellaneous Booking Information Wizard (which includes type, setup type, and setup count)

• Move Bookings Wizard

• Copy Reservation Wizard

• Copy Bookings Wizard

• Add Item Wizard

• Reservation Wizard

• Delete Booking Details Wizard

• Delete Item Wizard
What You Should Know About EMS Browser Windows

This topic guides you in working with elements of most pages or "browser windows" in EMS Desktop Client as you find and work with information.

Click-and-Drag

Column headers and borders enable you to change column location, order, or width. When a window offers the option shown below, you can click and drag a column header to group data by that column.

![Browser window with column headers](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/003_The_EMS_Window/What_You_Should_Know_About_EMS_Browser_Windows)

Right-Click Column Menu

These menus let you sort, hide, and group lists and resize.

Column Sort Arrows

Use the up/down arrows in each header to quickly sort a column in ascending or descending order.
Column Filters

Filtering options help narrow down lists.
User Settings

As a Desktop Client user, you can manage multiple aspects of your account for a superior user experience.

This section provides information on the following settings:

- User Preferences and Default Values
- Changing Your Password
- Resetting Window Coordinates
- Resetting Column Settings
- Defining Your Views

To set user preferences and default values:

Preferences, like system parameters, are settings that affect the basic functioning of your EMS system. The difference is that system parameters are global settings that affect all users on the system, whereas preferences are applicable only to your user account. You can set the values for many preferences for your EMS instance to better suit your working needs. These preferences include the time interval for Time dropdown fields, the size of the paper on which reports, confirmations, and invoices are to be printed, the format in which to send emails from your computer, and the default values for specific fields in the Reservation Wizard and other EMS client windows.

1. On the EMS main menu, click Settings > Preferences. The Preferences dialog box opens. The Preferences tab is the active tab.
2. Edit your user preferences as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Report Setup After Running Reports</td>
<td>The time interval displayed on a Time dropdown list—i.e., if you select 30 minutes, then options on the dropdown list are displayed as 1:00 1:30, 2:00 and so on. All Time dropdown lists are 24 hour lists.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>The size of the paper on which reports, confirmations, and invoices are printed. Values are Letter, Legal, and A4.</td>
</tr>
</tbody>
</table>
### Field Description

**Review Notifications When Navigator Opens**
If this option is selected, then a notification in the Dashboard is automatically marked as “Reviewed” if you select the notification, and then click Go To. If this option is not selected, then you must select a notification, and then click Reviewed to manually mark the notification as “Reviewed.”

**Do Not Save Window Coordinates**

**Email Format**
The format in which your emails are sent—HTML or Plain Text.

**Send Emails Using Department Email Address**
Select this option if you want the From email address for all the emails that you send from EMS to be the email address of the department that is associated with your user account.

**Use Global Email Settings**
If you want to use the global email settings that your EMS administrator has defined, then select this option.

**Use Gmail**

**Use Microsoft® Outlook**
Contact your EMS administrator with assistance in specifying these values.

**SMTP Email**
*Note:* If you are using SMTP Email settings that are specific to your account, then you also have the option of creating a signature that is to be included in all the emails that you send from EMS. You can design the signature in plain text on the Design tab or in HTML format on the HTML tab. You can always preview the signature on the Preview tab.

3. Open the Defaults tab, and set the default values for the indicated items.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>The values that you select here automatically populate the appropriate fields in the Reservation Wizard, and other EMS client pages.</td>
</tr>
<tr>
<td>Status</td>
<td><em>Note:</em> The event name can be a maximum of 30 characters, including spaces.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Event Type</td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td></td>
</tr>
<tr>
<td>Event Time</td>
<td></td>
</tr>
<tr>
<td>Reservation Source</td>
<td></td>
</tr>
<tr>
<td>Time Zone/Display Audit</td>
<td></td>
</tr>
<tr>
<td>Times in This Time Zone</td>
<td></td>
</tr>
<tr>
<td>Drawing Application</td>
<td></td>
</tr>
<tr>
<td>Payments Currency</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **OK** to close the Preferences dialog box and apply your edited preferences and default values.

**To change your password:**

When your EMS administrator first sets up your user account, your password is predefined for you. You can change this password if you want.

1. On the EMS main menu, click **Settings > Change Password**. The Change Password dialog box opens.
2. In the Old Password field, enter your current EMS password.
3. In the New Password field, enter the new password.
4. In the Re-enter New Password field, enter your new password again, exactly as you entered it in the New Password field.
5. Click **OK** to close the Change Password dialog box. The next time that you log in to EMS, you must use your new password.

**To reset window coordinates:**

1. On the EMS main menu, click **Settings > Reset Window Coordinates**.
2. You will receive a prompt notifying you that window coordinates have been successfully reset.

**To reset column settings:**

1. On the EMS main menu, click **Settings > Reset Column Settings**.
2. You will receive a prompt notifying you that the column settings have been successfully reset.

**To define your views:**

1. On the EMS main menu, click **Settings > My Views**. The My Views dialog box appears.
2. To create a new view, click **New**.
3. Under the **View** tab, provide a Description and Notes.
4. Under the **Rooms** tab, you can search for rooms by **Building** or **Room Type**.
   - To search by Room Type, choose a **Room** from the Room Type dropdown. A list will appear on the left-hand side of the View screen, including the available rooms, description, building, and room type.
   - To search by Building, choose a **Building** from the Building dropdown. A list will appear on the left-hand side of the View screen, including the available rooms, description, building, and room type.
   - Highlight the desired room and click **>>** to select the room. To select multiple rooms, click **>>**. Click **<<** to remove the selected rooms.
5. Click the **Audit** tab to view details on the View, including the date it was added, who it was added by, the date it was changed and who it was changed by.
6. Click **OK** to save your View.
Using the Dashboard

The Dashboard is a window that centralizes critical information about reservations in a single location. The information that is displayed on this window, including notifications, reminders, web reservations, and so on, provides you with the necessary input to manage your work in EMS.

In This Section (click to expand)

- Working With the Dashboard
- Managing Requests for Managed Space
- Guest Requests Tab
- Notifications Tab
- Reminders Tab
- Everyday User Reservations Tab
- Wait List Tab
- Reconfirm Dates Tab
- Building Hours Exceptions Tab
- Analytics Tab
- At A Glance Tab
Working With the Dashboard

The Dashboard is often used by administrative users to supervise, review, process, and approve many types of activities in the system. When the window first opens, it has the following tabs:

1. Notifications Tab
2. Reminders Tab
3. Everyday User Reservations Tab
4. Guest Requests Tab
5. Wait List Tab
6. Reconfirm Dates Tab
7. Building Hours Exceptions Tab
8. Analytics Tab
9. At A Glance Tab

You can sort columns on a tab in ascending or descending order, and you can rearrange columns by dragging the column heading, and you can change their widths.

Tip: Click the Dashboard icon at any time to open the Dashboard window.

See Also: Managing Requests for Managed Space

Customizing Your Dashboard Options

You can customize the appearance and behavior of your Dashboard under Options in the upper right corner.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Dashboard At Startup If Items Exist</td>
<td>Selected by default. The Dashboard window opens automatically after you log into EMS if any tab displays at least one item.</td>
</tr>
<tr>
<td>• Show Reminders</td>
<td>Selected by default. Indicates the tabs that are to be displayed on the Dashboard window.</td>
</tr>
<tr>
<td>• Show Everyday User Reservations</td>
<td></td>
</tr>
<tr>
<td>• Show Guest Requests</td>
<td></td>
</tr>
<tr>
<td>• Show Analytics</td>
<td></td>
</tr>
<tr>
<td>• Show Wait List</td>
<td></td>
</tr>
<tr>
<td>• Show Reconfirm Dates</td>
<td></td>
</tr>
<tr>
<td>• Show Building Hours Exceptions</td>
<td></td>
</tr>
<tr>
<td>• Show At A Glance</td>
<td></td>
</tr>
<tr>
<td>“Thru Today” includes xx Days Prior to Today</td>
<td>Indicates how far into the past that reminders are to be displayed in the “Thru Today” view. The default value is seven.</td>
</tr>
</tbody>
</table>

**Activate Flashing Indicator For:**
- Notifications
- Reminders
- Everyday User Reservations
- Guest Requests

Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if at least one item is displayed on any tab. Values are:

- Automatically—Immediately when there is at least one record that is displayed on the indicated tab, even when you are working in EMS.
- At Startup Only
- Never
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activate Flashing Indicator</strong></td>
<td>Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if tasks on the tab require your attention. Values are:</td>
</tr>
</tbody>
</table>
| For:                          | • Wait List  
|                               | • Reconfirm Date  
|                               | • Reminders  
|                               | • Building Hours  
|                               | • Exceptions                                                                                                                                 |
|                               | • At Startup Only                                                                                                                                 |
|                               | • Never                                                                                                                                          |
Managing Requests for Managed Space

This topic guides you in approving "pending requests," which are requests for space that require supervisory approval and appear in your Dashboard.

Concept: You Use the Request/Approval Model to Oversee "Managed Space"

Once your system administrator has configured facilities (rooms, categories, services, resources, and so on), he or she can configure special process templates for "managed space," which is meeting space that may require additional oversight and an approval process to finalize a reservation. For example, your organization may need specialized space like the President's Conference room, or a large banquet hall, to be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically, managed space involves services, expenses, and invoicing that affect multiple stakeholders and departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook does not show the request status of such a reservation.

See Also: EMS Terminology: Types of Users

1. Click the Dashboard icon in the EMS Desktop Client toolbar.

2. Click the Guest Requests tab, which displays requests for space that require supervisory approval. Such requests are submitted through EMS Web App using process templates designated for "Unauthenticated Users." An unprocessed request is in Pending status.
The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter the list, click **Refresh**.

---

**Approving or Working With a Pending Request**

1. Select the request you wish to work with, and click **Edit** to launch the Guest Request dialog box, which shows all the information submitted for the request through EMS Web App. The dialog box always has a Description tab, a Web Questions tab, and an Audit tab. If the request included resources or setup notes, it also has a Services tab.

![Guest Request dialog box](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/Using_the_Dashboard/011_Managing_Requests_for_Managed_Space)

2. **To ask the requestor for further clarification before approving the request**, edit the request without processing it:

   - You can ask questions and add comments about the request (for example, “Will alcohol be served at the event?”) in the **Notes** field on the Description tab. When the user checks the request in EMS Web App, these notes will display.
   - To indicate to the guest user that you are reviewing the request, you can set the **Request Status** to **In Progress**.
   - To see the guest's answers to any predefined questions in EMS Web App, open the Web Questions tab.
   - To see service requests, click the Services tab. Double-click a category to see details on the right.

   When you have finished interacting with the request, click **OK** to save your changes and notify the requestor.

3. **To process the request and create a reservation**, change the **Request Status** field to a new status (such as **Approved**) and click **Process** on the Description tab. The reservation opens in the Reservation Wizard and you must **finish making the reservation in the Reservation Wizard window that appears**.

   - If the reservation includes services, the Process Guest Request Details window opens next. To process the services immediately, use the options on this window, or to process the services later, click **Cancel**. (You can later open the reservation on the Dashboard > Guest Requests tab, and on the Services tab, click **Process**.)
Deleting a Request

1. Select the guest request, or CTRL-click to select the multiple requests, and then click **Delete**.

2. Click **Yes**. The message closes. The selected guest requests are deleted.

Printing a Request

1. Select the guest request, or CTRL-click to select the multiple requests, and then click **Print**. An preview of the selected requests opens, with options to print a hard copy, export the requests to a .pdf, and email the requests.

2. Select the option or options that best fit your working needs.
Guest Requests Tab

The Guest Requests tab displays requests for space that require supervisory approval. Such requests are submitted through EMS Web App using process templates designated for "Unauthenticated Users." An unprocessed request is in Pending status.

Concept: You Use the Request/Approval Model to Oversee "Managed Space"

Once your system administrator has configured facilities (rooms, categories, services, resources, and so on), he or she can configure special process templates for "managed space," which is meeting space that may require additional oversight and an approval process to finalize a reservation. For example, your organization may need specialized space like the President's Conference room, or a large banquet hall, to be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically, managed space involves services, expenses, and invoicing that affect multiple stakeholders and departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook does not show the request status of such a reservation.

See Also: EMS Terminology: Types of Users

The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter the list by Status or Building (on the left panel), click Refresh.
Notifications Tab

**Concept: Changing Events Can Automatically Notify Users**

Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when changes or additions have been made in EMS for bookings and reservations, service orders, room types, setup types, user accounts, and so on. When you create a reservation or booking that has these notifications turned on, users will receive these alerts without requiring additional effort from you. Be sure to review these notification settings during the process of creating or modifying events.

If your EMS Web App implementation uses the [Integration with Exchange](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/Using_the_Dashboard/020_Notifications_Tab), you can handle notifications using Outlook.

**Concept: Integration to Microsoft® Exchange Enables You to Use Outlook®**

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of meeting rooms and attendees, and send Microsoft® Outlook® meeting invitations, all from within EMS Web App.

You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange in order to configure and use this capability. If you are unsure if your organization is licensed for Integration to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account Executive.

**Notifications Tab Overview**

When the Notifications tab first opens, all the notification rules that include you are listed in the Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new notifications (notifications with the current day’s date) is displayed.
The tab is interactive. For **Notification Rules**, you can:

- Select a rule, and under **Show**, select **Unreviewed** to view all unreviewed notifications for future bookings.
- Select a rule, and under **Show**, select **Reviewed** to view all reviewed notifications for future bookings.
- Select a rule, and under **Show**, select **Old** to view all notifications for past bookings.

For **Notifications**, you can:

- Select a notification to view detailed information about the notification (such as new bookings, the changes made to a booking, and the users who were notified of the changes) in a pane at the bottom of the window.
- Select **Show New Only** to show only new notifications (notifications with the current day’s date) for the notification rules.
- Select a notification, and then click **Reviewed** to mark a notification as “Reviewed.”
- Select a notification and then click **Go To** to open the item to which the notification refers.
- If the notification is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.
- If the notification is attached to a group, then the Group window opens with the group information displayed in the window.
- Click **Refresh** to check for notifications that have been issued since you opened the Dashboard.
- Select a notification, or CTRL-click to select multiple notifications, and then click **Delete** to delete the notifications from the Notifications tab.
Reminders Tab

A *comment* is a text entry that explains or clarifies a reservation, booking, group, or service order. A *reminder* is a comment that has a due date associated with it. The Reminders tab displays all the reminders for which you are the responsible user and that, by default, have a due date through the current day’s date.

![Image of Reminders Tab](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/Using_the_Dashboard/030_Reminders_Tab)

**Process Overview:**

To work with reminders, you can:

- [Change the Reminders View](#)
- [Create Unattached Reminders](#)
- [Change a Reminder](#)
- [Delete a Reminder](#)
- [Print a Reminder](#)
- [View an Item To Which a Reminder is Attached](#)
- [Mark a Reminder Complete](#)
- [Reassign Multiple Reminders Between EMS Users](#)

**Changing the Reminders View**

By default, when the Dashboard window first opens, the Reminders tab displays all the reminders for which you are the responsible user and that have a due date through the current day’s date. You can do one or more of the following to change this view:

- To view the reminders for which other users are responsible, simply select the user or users in the Responsible User pane.
To view only a specific group of reminders for which you or others are the responsible users, change the viewing criteria.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View reminders that have the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.</td>
</tr>
<tr>
<td>Reminder Type</td>
<td>The default value is (all).</td>
</tr>
<tr>
<td>Attached To</td>
<td>The default value is (all). To view reminders that are not attached to any item (reservation, booking, group, or service order), select (none). See “To create an unattached reminder”.</td>
</tr>
<tr>
<td>Search in Text</td>
<td>Enter the string by which to search for specific reminders. (The search is carried out on the Notes field for the reminder.) Your search is limited to the exact order of the characters in the string, but the search string is not-case sensitive and it can appear anywhere in the search results. For example, a search string of cat returns reminders that have “catering” or “Mary’s catering” in the Notes field.</td>
</tr>
<tr>
<td>Date Completed</td>
<td>Available only if Exclude Complete is not checked.</td>
</tr>
<tr>
<td>Exclude Completed</td>
<td>Selected by default. Clear this option to display completed reminders in the Reminders list. To display completed reminders that meet the other viewing criteria, regardless of their completion dates, leave the Date Completed fields blank; otherwise, to view completed reminders that were completed by a specific date, you can enter a Starting date or a date range in the Date Completed fields.</td>
</tr>
<tr>
<td>Hide Cancelled</td>
<td>Not selected by default. Select this option to display canceled reminders in the Reminders list.</td>
</tr>
</tbody>
</table>

Creating Unattached Reminders

When you create reminder on the Navigator, the reminder is attached to a specific reservation, booking, or booking detail. Similarly, when you create a reminder on the Groups window, the reminder is attached to a specific group. If needed, however, you can create a reminder that addresses just your general business needs and is not attached to
any specific item. For example, you can create a reminder about “preparing for your organization’s yearly safety inspection.” Any reminder that you create from the Reminders tab on the Dashboard window is an unattached reminder.

1. Click New. The Reminder dialog box opens.

![Reminder dialog box](https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/Using_the_Dashboard/030_Reminders_Tab)

2. Do one of the following:
   - Select a Reminder Type.
   - If none of the pre-configured Reminder Types meets your working needs, then select (user-specified), and in the Description field, enter a description for the reminder type.

   The Responsible User field is populated with your User ID and the Date Due field is populated with the current day’s date.

3. Optionally, change the Responsible User, Date Due, or both.

4. If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank. (This field is populated automatically when you or another user completes the reminder. See "To complete a reminder").

5. Optionally, in the Notes field, enter any further explanation or information about the reminder. Click Spelling to spell-check the reminder before you save it.

6. Click OK. The Reminder dialog box closes. The newly created reminder is not attached to an item. It might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.

### Changing a Reminder

1. On the Reminders list, select the reminder that you are editing, and then click Edit. The Reminder dialog box opens.

2. Edit the reminder as needed. Optionally, click Spelling to spell-check the reminder before you save the edited reminder.

3. Click OK. The Reminder dialog box closes. If the reminder is attached to an item such as a reservation, then the reminder remains attached; otherwise, it is saved as an unattached reminder.
Deleting a Reminder

You can delete any reminder (attached or unattached) regardless of its due date and regardless if it is completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete. A message opens asking you if it is **OK** to delete the reminder.

2. Click **Yes**. The message closes and the reminder is deleted.

Printing a Reminder

1. On the Reminders list, select the reminder that you are printing, and then click **Print**. An onscreen preview of the reminder opens. The preview window contains options for printing a hard copy of the reminder, for emailing the reminder, and so on.

   *Onscreen preview for a printed reminder*

2. Select the option or options that best fit your working needs.

Viewing an Item To Which a Reminder is Attached

On the Reminders list, select a reminder, and then click **Go To**. The Attached To column for the reminder must state anything other than “Unattached.”

- If the reminder is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.

- If the reminder is attached to a group, then the Group window opens, with the group information displayed in the window

Marking a Reminder Complete

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are completing.

2. Click **Completed**. A message opens asking you if it is **OK** to set the selected reminders as completed.

3. Click **Yes**. The message closes. The reminders are completed with a date equal to the current day’s date. The reminders might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.

https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS_Desktop_Client/Using_the_Dashboard/030_Ren

Updated: Tue, 21 Nov 2017 14:38:28 GMT
Powered by 55
Reassigning Multiple Reminders Between EMS Users

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are reassigning.

2. Click Reassign. The Select User dialog box opens. This dialog box lists all the users for your EMS implementation.

3. Select the user to whom you are reassigning the reminder.

   To search for a user, enter a search string in the Search field. The search string is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of Admin returns both Admin users and SysAdmin. The list of users that meet your search string is dynamically updated as you enter the string.

4. Click OK. A message opens, asking you if you are sure that you want to reassign the selected reminders to the user.

5. Click Yes. The Select User dialog box and message close and the reminder is reassigned.
Everyday User Reservations Tab

The Everyday User Reservations tab displays any reservation that was submitted through EMS Web App made in Self Serve mode.

You can select options to filter the reservations list. Status and Building/Area/View filters show on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step. Date filters show on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional. After you select or edit the filtering options, click Refresh.

Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Wait List Tab

The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides an indicator when the requested room becomes available.

The tab is interactive. You can:

• Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Reconfirm Dates Tab

The Reconfirm Dates tab displays reservations that have been booked in a status that requires the Reconfirm Date option (for example, a Tentative or Hold status). The list of reservations is automatically sorted in ascending order by Reconfirm Date. You use this tab as a reminder to reconfirm such reservations.

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.

- Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

- Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

- Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Building Hours Exceptions Tab

The Building Hours Exceptions tab displays reservations that occur outside of configured building hours.

The tab is interactive. You can:

• Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Analytics Tab

The Analytics tab provides quick access for queries that have been defined using the Query builder and to which you have access as a user. You can run these queries from the Analytics tab.

To run a query from the Analytics tab

1. In the upper left corner of the Analytics tab, click Select Queries. The Queries dialog box opens. This dialog box lists the queries that have been defined using the Query builder and to which you have access.

2. Select the queries that you want to run, and then click OK. The Queries dialog box closes. The selected queries are displayed in the Queries pane (upper left) on the Analytics tab.

3. In the Queries pane, select the query that you want to run, and then select the date for which the data in your EMS database is to be queried.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates. Note: For some queries, if you select Custom, a Use Specific Times option becomes available. If you enter the same date for the starting date and ending date, you can select Use Specific Times, and then enter a starting time and ending time to query the data for in specific time range on the same day.</td>
</tr>
</tbody>
</table>

https://success.emssoftware.com/EMS_V44.1/001_Getting_Started_with_EMS/Desktop_Client/Using_the_Dashboard/090_Ana

Updated: Tue, 21 Nov 2017 14:38:28 GMT

Powered by
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Month</td>
<td>The starting date is set to the first day of the previous month and the ending date is set to the last day of the previous month.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>Quarters are based on a calendar year:</td>
</tr>
<tr>
<td>This Quarter</td>
<td>• First quarter is 1/1 through 3/31.</td>
</tr>
<tr>
<td>This Quarter To Date</td>
<td>• Second quarter is 4/1 through 6/30.</td>
</tr>
<tr>
<td></td>
<td>• Third quarter is 7/1 through 9/30.</td>
</tr>
<tr>
<td></td>
<td>• Fourth quarter is 10/1 through 12/31.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current day’s date is 11/22/2010, and you select Last Quarter, then the starting date is set to 7/1/2010 and the ending date is set to 9/30/2010.</td>
</tr>
<tr>
<td>Last Year</td>
<td>The starting date is set to 1/1 of the previous year, and the ending date is set to 12/31 of the previous year.</td>
</tr>
<tr>
<td>This month</td>
<td>The starting date is set to the first day of the current month and the ending date is set to the last day of the current month.</td>
</tr>
<tr>
<td>This Year</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to 12/31 of the current year.</td>
</tr>
<tr>
<td>This Year to Date</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to the current day’s date.</td>
</tr>
</tbody>
</table>

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data. If the query returns data, then the results are displayed in the Results pane on the Analytics tab.

6. Optionally, do one or more of the following:
   - To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the appropriate file type. A dialog box opens in which you can specify the file name (the default file name is the name of the query, but you can always edit this), and the location to which to save the file.
The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML file is .xml and you cannot change this.

• To generate an onscreen preview of the printed query results, click Print. The preview window contains options for printing a hard copy of the query results, for emailing the results, and so on. Select the option or options that best fit your working needs.

Onscreen preview of a query results

• If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an onscreen preview of the charted data. The preview window contains options for printing a hard copy of the chart, for emailing the chart, and so on. Select the option or options that best fit your working needs.

Onscreen preview of query results that are charted/graphed
At A Glance Tab

The At A Glance tab provides quick access to high-level booking statistics for events at your organization or facility. You can select to show booking statistics by category, by event type, by group type, by reservation source, by room type, or by status.

By default, when the tab first opens, the date is set to the current day’s date, and category is the selected display type.

To view booking statistics for your facility on a given date

1. Select options (Status and Building) on the left pane of the tab to filter the results that are displayed on the tab.

2. Change the date and/or the display type as needed to view the bookings statistics for a selected date.